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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any intention other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and a basic knowledge of English. It is therefore essential that only
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at
the appropriate place in the product documentation. Keep the basic safety instructions and the product
documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories.

Symbols and safety labels

A A&MNAASG BN L

Notice, general Caution Danger of Warning! PE terminal Ground Ground Be careful when
danger location when electric Hot surface terminal handling
handling shock electrostatic
Observe prgduct heavy sensitive
documentation equipment devices

| O 0 == ~ ~ O

ON/OFF supply | Standby Direct current Alternating current | Direct/alternating | Device fully protected by
voltage indication (DC) (AC) current (DC/AC) double (reinforced) insulation
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Basic Safety Instructions

Tags and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

indicates a hazardous situation which, if not avoided, will result in death or
A DANGER serious injury.

indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A WARNING

indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These tags are in accordance with the standard definition for civil applications in the European Economic
Area. Definitions that deviate from the standard definition may also exist in other economic areas or
military applications. It is therefore essential to make sure that the tags described here are always used
only in connection with the related product documentation and the related product. The use of tags in
connection with unrelated products or documentation can result in misinterpretation and in personal injury
or material damage.

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level,
max. transport altitude 4500 m above sea level. A tolerance of £10 % shall apply to the nominal
voltage and £5 % to the nominal frequency.

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
death.

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
death.
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Basic Safety Instructions

Electrical safety

If the information on electrical safety is not observed either at all to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

10.

1.

12.

13.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with an earthing contact and protective earth connection.

Intentionally breaking the protective earth connection either in the feed line or in the product itself is
not permitted. Doing so can result in the danger of an electric shock from the product. If extension
cords or connector strips are implemented, they must be checked on a regular basis to ensure that
they are safe to use.

If the product does not have a power switch for disconnection from the AC supply network, the plug of
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the
power plug is easily reachable and accessible at all times (corresponding to the length of connecting
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from
the AC supply network. If products without power switches are integrated into racks or systems, a
disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cable on a regular basis to
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully
laying the power cable, you can ensure that the cable will not be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.

The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse
only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages V,,s > 30 V, suitable measures (e.g. appropriate
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to
avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the PE terminal on site and the
product's PE conductor must be made first before any other connection is made. The product may be
installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fused in such a way that anyone who has access to the product, as
well as the product itself, is adequately protected from injury or damage.
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14.

15.

16.

17.

18.

Basic Safety Instructions

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1. Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal”, item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no
other settings or functions may be used as described in the product documentation. The objective is to
prevent personal injury (e.g. due to laser beams).
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Basic Safety Instructions

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation
resistance measurement, leakage current measurement, functional test). This helps ensure the
continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek
medical aid immediately.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.
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Informaciones elementales de seguridad

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal

1. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

Informaciones elementales de seguridad

Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estdndares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Informaciones elementales de seguridad

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacién debida en la documentacién del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacién del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccion de personas, que encontraran en el capitulo correspondiente de la
documentacién del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios.

Simbolos y definiciones de seguridad

4 i _L

A0 kg = —
Aviso: punto de Atencion en Peligro de Adver- Conexion a Conexion | Conexién Aviso: Cuidado
peligro general el manejo de | choque tencia: conductor de | atierra amasa en el manejo de
dispositivos eléctrico superficie proteccion dispositivos
Observar la » de peso caliente sensibles a la
documentacion elevado electrostatica

del producto

(ESD)
| O d) —— T~ TN D
Tension de Indicacion de Corriente Corriente alterna | Corriente El aparato esta protegido
alimentacién de estado de continua (DC) (AC) continua / en su totalidad por un
PUESTAEN espera Corriente alterna | aislamiento doble
MARCHA / (Standby) (DC/AC) (reforzado)
PARADA
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Informaciones elementales de seguridad

Palabras de seiial y su significado

En la documentacién del producto se utilizan las siguientes palabras de sefal con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

= ATENCION identifica un peligro con riesgo reducido de provocar
A ATENCION lesiones leves o moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, danarlo.

En la documentacién del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicion en otras areas econdémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacién del producto y
solamente en combinacion con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas Yy tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de sequridad del trabajo y de prevencién de accidentes.

1. Sino se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, grado de suciedad 2, categoria de sobrecarga eléctrica 2, uso
solamente en estancias interiores, utilizacion hasta 2000 m sobre el nivel del mar, transporte hasta
4500 m sobre el nivel del mar. Se aplicara una tolerancia de +10 % sobre el voltaje nominal y de
+5 % sobre la frecuencia nominal.

2. No situe el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacién del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacién de modo distinto al indicado en la documentacién del producto, pueden
causarse lesiones o incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.
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Informaciones elementales de seguridad

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

10.

1.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion maévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcién intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, se debera considerar
el enchufe del cable de conexién como interruptor. En estos casos se debera asegurar que el enchufe
siempre sea de facil acceso (de acuerdo con la longitud del cable de conexidon, aproximadamente

2 m). Los interruptores de funcién o electrénicos no son aptos para el corte de la red eléctrica. Silos
productos sin interruptor estan integrados en bastidores o instalaciones, se debera colocar el
interruptor en el nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacién adecuadas, de que el cable de conexion a red no pueda ser dafiado o de que nadie
pueda ser danado por él, p. ej. al tropezar o por un choque eléctrico.

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensién Uy > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacién
de tensién, corte protector, aislamiento etc.).

Para la conexion con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.

1171.0000.42-05.00 Page 9



12.

13.

14.

15.

16.

17.

18.

Informaciones elementales de seguridad

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles danos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningun objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. ej. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitroceluldsicas.

Funcionamiento

1.

2.
3.

4.

El uso del producto requiere instrucciones especiales y una alta concentracién durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos
(p- €j. el niquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones
alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la conjuntiva o
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y
evitar cualquier molestia o dafo a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacién”, punto 1.
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5.

Informaciones elementales de seguridad

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcién natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

En caso de que un producto Rohde & Schwarz contenga un producto laser (p. ej. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacion del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensién de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicidn de resistencia de aislamiento, medicion de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe sequir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Mantener baterias y celdas fuera del alcance de los nifios. En caso de ingestion de una celda o
bateria, avisar inmediatamente a un médico.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.
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Informaciones elementales de seguridad

6. En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacién y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacion utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafos.

Eliminacion

1.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formaciéon adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacién de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacion incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.
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Qualitatszertifikat
Certificate of quality
Certificat de qualité

Sehr geehrter Kunde,

Sie haben sich fur den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Qualitatsmanage-
mentsystems entwickelt, gefertigt
und gepruft. Das Rohde & Schwarz-
Qualitdtsmanagementsystem ist u.a.
nach I1ISO9001 und ISO 14001
zertifiziert.

Der Umwvelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche Weiterentwicklung
nachhaltiger Umweltkonzepte

1 ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear Customer,

You have decided to buy a
Rohde & Schwarz product. You are
thus assured of receiving a product
that is manufactured using the most
modern methods available. This
product was developed, manufactured
and tested in compliance with our
quality management system stan-
dards. The Rohde & Schwarz quality
management system is certified
according to standards such as
ISO9001 and ISO 14001.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

1 1SO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Certified Environmental System

1S0 14001

Cher client,

Vous avez choisi d'acheter un pro-
duit Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d'apreés les
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests
respectent nos normes de gestion
qualité. Le systéme de gestion qualité
de Rohde &Schwarz a été homologué,
entre autres, conformément aux nor-
mes ISO9001 et ISO 14001.

Engagement écologique

1 Produits a efficience énergétique

1 Amélioration continue de la durabilité
environnementale

1 Systeme de gestion de I'environne-
ment certifié selon ISO 14001

1171.0200.11 V 04.01




Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

USA & Canada Monday to Friday  (except US public holidays)
8:00 AM - 8:00 PM  Eastern Standard Time (EST)

Tel. from USA 888-test-rsa (888-837-8772) (opt 2)
From outside USA  +1 410 910 7800 (opt 2)

Fax +1 410 910 7801

E-mail CustomerSupport@rohde-schwarz.com
East Asia Monday to Friday  (except Singaporean public holidays)

8:30 AM - 6:00 PM  Singapore Time (SGT)

Tel. +65 6 513 0488

Fax +65 6 846 1090

E-mail CustomerSupport@rohde-schwarz.com
Rest of the World Monday to Friday  (except German public holidays)

08:00 - 17:00 Central European Time (CET)

Tel. +49 89 4129 13774

Fax +49 (0) 89 41 29637 78

E-mail CustomerSupport@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-04.00
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1 Overview
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Acoustic Measurements on Hearing Aids

Tests of basic properties of hearing aids are specified in standards
IEC 60118 and ANSI S3.22. They comprise measurement of output sound
pressure level, frequency responses, output SPL over input SPL, harmonic
distortion, battery current drain and AGC settling.

Audio Analyzer R&S UPV with option R&S UPV-K7 provides a test system
which, together with the necessary acoustic accessories, allows
measurements according to IEC60118-0:1983, IEC60118-1:1995, IEC60118-
2:1983, IEC60118-7:2005 and ANSI S3.22-2003.

In addition to standard measurements it is possible to create own tests by
customizing the available parameters.

With additional option R&S UPV-K71, tests according to IEC60118-15 using
speech signal can be performed.

Automatic test sequences can be compiled from the available tests, and
results are compiled for subsequent creation of test reports.



Acoustic Measurements on Hearing Aids

2 Preparation and Start of the Application Software

1401.9353.12-03

Required Measuring Instruments and Accessories
The Audio Analyzer R&S UPV with option R&S UPV-K7 is required for the
measurements.

Acoustic devices such as measurement couplers, a calibrator and other
accessories are required for the measurements. The following equipment

from Briel & Kjeer or G.R.A.S. may be used:

Device

Description

Type (examples)

Hearing aid test box

Anechoic box with built-in sound
source and induction loop, feed-
throughs for the most important
connection lines

R&S UPL-B7 or
Interacoustics
TBS25 or B&K 4232

Measurement microphone

2" measurement microphone for
measurement of artificial mouth
output during calibration, to be
inserted into IEC 126 2cc coupler,
and for comparison measurement

B&K 4938 with B&K
2670 or G.R.A.S.
40BP with G.R.A.S.
26AC

Low-noise measurement
microphone

2" measurement microphone with
high sensitivity and low self-noise for
speech tests according to

IEC 60118-15.

G.R.A.S. 40AP with
G.R.A.S. 26AC and
right-angled adapter
RA0001

IEC 126 coupler

Acoustic coupler according to
IEC 126

Part of R&S UPL-B7
(with internal
microphone or with
4" microphone with
preamplifier)

IEC 126 coupler for 5"
microphone

Acoustic coupler according to
IEC 126, for use with %2” microphone

G.R.A.S. RA0038

IEC 711 ear simulator
(optional)

IEC 711 type occluded ear simulator
with adapters for calibration and
connection to the output of the DUT,
with 1/2” - preamplifier

B&K 4157 & 2669 or
G.R.A.S. RA0045

Acoustic calibrator

Sound level calibrator or
pistonphone for calibrating the
measuring microphones

B&K 4231 or
G.R.AS. 42AB

Microphone power supply

Power supply and preamplifier for
the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA

Note: With the amplifier set to 0 dB, the microphone power supply
B&K 2690A0S2 produces too much noise for measuring idle
noise and distortion. It is therefore advisable to set a gain of
20 dB.

Theoretically the reference microphone for sound source
calibration and comparison measurement should be a free field
type and the IEC 126 coupler should be used with a pressure
field type. However with a »” microphone the frequency
response difference is negligible up to at least 10 kHz.
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Acoustic Measurements on Hearing Aids

When wusing a 2" pressure microphone as reference
microphone, a good approximation of a flat free field response is
achieved if the microphone is place such that the sound
incidence is from 90 degrees relative to the microphone axis.

Note: An external USB keyboard and a mouse must be connected to
the R&S UPV.

Caution: R&S UPV-K7 does not support the use of headphones. Do not
connect headphones to the R&S UPV during hearing aid tests.
High level signals may be present at the headphone connector.

The audio analyzer must meet the following firmware requirements:
e R&S UPV firmware version 3.1.0 or higher
e License key R&S UPV-K?7 installed

e For tests with speech-like signals according to IEC 60118-15, license key
R&S UPV-K71 must be installed in addition.

Installing the Software

The application program requires key K7 to be installed. The application
program and the key are installed in the factory in case a new R&S UPV is
ordered together with this option. If the option is ordered separately, the key
as well as the installation manual is part of the delivery.

The program required and the associated files are in the folder “UPV-K7
Software” on the installation CD supplied with the R&S UPV-K7 option. It is
recommended to copy the files MCRInstaller.exe, UPV-K7_12011.msi,
Config.ini, dotnetfx.exe, Setup.Exe and Settings.Ini from the folder “UPV-K7
Software” on the installation CD to drive D: on the R&S UPV hard disk
drive, e.g. to a folder named “D:\R&S Software\UPV-K7\Version 1.2.0”. Run
the file “Setup.Exe” to start the installation. Follow the instructions of the
installer on the screen. Run installer “MCRInstaller.exe” to install the Matlab
runtime for option UPV-K71 (“Hearing aids tests using speech-like signals”).

Verification of Installation

After the installation has terminated, a folder C:\Program
Files\Rohde&Schwarz\UPV-K7 Hearing Aid tests must have been created.
It must contain 30 files plus a folder “Data” which in turn must contain
150 files, and a folder “Sequences” with sub-folders “ANSI_S3 227
“IEC60118-0,-1,-2” and “IEC60118-7".

Upon first startup, the application program creates the folder D:\Hearing.
After the program has been exited without any further action, this folder
must contain 152 files.

If the software reports a missing key code at the first start, delete folder
“D:\Hearing” (if existing) and install the missing key code before starting the
software again.
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Test Setup

ANLG AUX OUT

Microphone
Power Supply

Coupler Cable
/ p

Battery Adaptor Cable

Loudspeaker Cable —

Telecoil Cable

Fig. 1 Test setup and connection of external components

The following cables are required to connect speaker, induction loop and
battery voltage supply of the test box delivered with R&S UPL-B7 to the
R&S UPV. The microphone signal from the microphone power supply may
be connected to the analyzer input with a BNC cable and a R&S UPL-Z1
adapter. If a custom made BNC to XLR cable is used, it should be made
following the schematics of the R&S UPL-Z1 adapter (see R&S UPV
manual, chapter “Configuring the Analog Analyzer”).
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XLR female
e open ends
3
2
.
Loudspeaker Cable

XLR female
5 e 6.3 mm mono jack male
2 1:::::::::::::::::::: **** % Ty
T

Telecoil Cable
XLR male 3.5 mm stereo jack male
) - S

g _o==p=====o -
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***** L I_
D: 4 diodes: 1N4007 or similar (1A forward current)
R1: resistor 2 Ohm, 1% BNC male
R2: 2 resistors 1 Ohm, 1%
Battery Adaptor Cable
Fig. 2 Connection cables for R&S UPL-B7 (Interacoustics TBS 25) test

box

The cables shown in Fig. 2 can be ordered as Accessory R&S UPV-Z7.

The cables of R&S UPL-B7 can be re-used for R&S UPV-K7. As the supply
voltage is now provided by the “ANLG AUX OUT” on the rear panel of the
R&S UPV, the following adapter is required in addition.

6.3 mm stereo jack female BNC male

Fig. 3 Adapter cable to connect the R&S UPL-B7 battery supply cable

to the “ANLG AUX OUT” of the R&S UPV
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Starting the Application Software

After installation, the program can be started by double-clicking the Icon
“UPV-K7 Hearing Aid Tests” or by clicking “R&S UPV Applications > UPV-
K7 Hearing Aid Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the
measurement coupler used.

The entered selections are stored with the settings and automatically
loaded at the next start of the program.

At each start of the program, the ambient conditions temperature, relative
humidity and atmospheric pressure are queried for protocol purpose. The
entered values are not stored in the settings, because the ambient
conditions are supposed to change with time. The query can be deselected
and values can be changed any time in the “Options” menu.

Select Standard

none

[EC118-0.1.2

[EC 118-7

[EC 11815

AMS| 5322

r AllEsrarl standard
MEeasurenents

[T Do not show this dislog again

Cancel |

=

Fig. 4 Query window for selection of applied standard

If “none” is selected in the standard selection window, all measurements
appear in the “Measurement” menu. If a standard is selected, all
measurements appear in the “Measurement” menu, but compliant
measurements are checked in the menu. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu.

10 E-3
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Select Ear Simulator

[EC 126

[EC 711

[T Do not show this dislog again

Cancel | k. I
y

Fig. 5 Query window for selection of ear simulator

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
below).

The next window to open is the input window for the ambient conditions
temperature, relative humidity and atmospheric pressure.

Ambient Conditions

Temperature

[ w0z [t =
Felative hurmidity

| 00 %

Atmospheric pressure

| 0.0 [kFa =]
Cancel | Ok I/

o

Fig. 6 Query window for input of ambient conditions

The units can be switched between °C and °F and between kPa and
mmHg, respectively. After the last of the three selection windows has been
closed, the main window of the R&S UPV-K7 opens.
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File Data Calibration Measurement Standards Corfig, Meas. Seguence Report  Options  Help

TestResults Dverview
Select ‘ Date and Time | Measurement Title | Test Object |Verd| | Comment

!
lEC1z04.2  [EC7N |substiution  |Sample Hearing Aid1 | 1.300%
Fepeat|ast: Report lagt FHepeat|ast Report lagt Exit
Eeasiremest measurement SEQUERICE] sequence

Fig. 7 Main window after first start of the program

Initially the data grid in the centre of the screen which shows the result
overview is empty. The screenshot below shows an example after a
number of measurements have been made.
@Hea

Fle Data Calibration Measurement Standards Config. Mea

Sequence Report  Options  Help

Test Results O verview

Select | Date and Time | Measurement Title | Test Object | Werdi | Comment =
| 07/02/2010 14:46:50 OSPLI0[IEC-7) Sample Hearing Aid 1 Pass
| 07/02/2010 14:47:30 Full-0n Gain (IEC-7] Sample Hearing Aid 1 FAIL
| 07/02/201014:48: 21 Fieference Test Setting (IEC-7) Sample Hearing Aid 1 Pass
(N 07/02/201014:45:02 Frequency Responze (IEC-F] Sample Hearing Aid 1 FaIL
| 07/02/201014:43:21 Input - Dutput Characteristics [IEC-7] Sample Hearing Aid 1 PASS
(I 07/02/2010 14:43:46 Dynarnic Behaviour [EC-7) Sample Hearing Aid 1 FAIL
| 07/02/2010 14:50:05 Harmonic Distortion [IEC-7) Sample Hearing Aid 1 PASS
| 07/02/2010 14:50:23 Battery Current [IEC-7) Sample Hearing &id 1 PASS
| 07/02/201014:50:58 E quivalent Input Moise (IEC-7) Sample Hearing Aid 1 PASS
(N 07/02/201014:51:25 Frequency Response Induction [IEC-7] Sample Hearing Aid 1 PaSS
| Output SPL at Mawimum Gain, Induction [IEC-  Sample Hearing Aid 1 FalL
(N Full-On G ain [IEC-7] Sample Hearing Aid 1 PASS
| Frequency Response [IEC-7] Sample Hearing Aid 1 PASS
(I 0SPLS0IECD) Sample Hearing Aid 1 FAIL
[» | = o7/z2mo150301 0SPLI0 (IEC-0) Sample Hearing Aid 1 PASS
| == 07/02/2010 15:23:58 OSPL30 IEC-0) Sample Hearing Aid 1 Fall
| 07/02/20M1015:24.15 Fieference Test Setting (IEC-0) Sample Hearing Aid 1 Pass
(N 07/02/2010 15:25:21 0SPLS0IEC-D) Sample Hearing Aid 1 FAIL
| 07/02/201015:25:37 Reference Test Setting [IEC-0] Sample Hearing Aid 1 PASS
(N 07/02/201015:26:01 Field of Frequency Response Curves(IEC-0] Sample Hearing Aid 1 PASS
| 07/02/2010 15:26:23 Input - Dutput Characteristics (|EC-2) Sample Hearing Aid 1 PASS o
(I 07/02/2010 15:26:39 Dynarnic Behaviour at Speech Level (IEC-2) Sample Hearing Aid 1 FAIL
| 07/02/2010 15:26:48 Harmonic Distortion IEC-0) Sample Hearing &id 1 PASS
| - O07/02/20M015:26:52 B atterp Current [IEC-0] Sample Hearing Aid 1 PaSs
I — 07/02/20M015:26:59 Equivalent Input Moise (IEC-0] Sample Hearing Aid 1 Pass =
4 | o
IECTI801.2  ECFI [Substitution |sampe Hearng 2id 1| 1.300%
Hepeat|ast Repoit last | Hepeat|ast | Report last | el |
MEasUEMERT MEasLreEment SEQUETICE] SEQUENCE

Fig. 8 Main window with results
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Options (General settings)

| Options  Help
| Zontinuaus Current Measurement
Measurement Frequency Range
High Pass (Rumble) Filter
Low Pass (Hiss Moise) Filker
v fAdaptive Measurement (Function Setting)
Standard
v Seleck Standard at Starkup
Ear Simulator
Select Ear Simulator at Startup
ambient Conditions
v Query gmbient Conditions at Skartup
Test Method
Microphone Location MLE (IEC 60118-15)
v Use Coupler Mic as Reference Mic
v Show Operator Instructions
Delay before closing a measurement in a sequence ...
v Store Results of Further Measurements
Store Loaded Curve Data ko Resulks
Battery YWoltage
Report Settings

Fig. 9 Options menu

The “Options” menu in the main window allows to change a set of general
settings like ear simulator, test method and battery voltage, which are valid
for all or at least a plurality of the tests.

“Continuous current measurement” allows to measure the supply
current at analyzer input 2. This option can only be selected with the
substitution method. The value of the shunt resistor for the current
measurement can be entered in the calibration menu. By default it is set to
2Q.

“Measurement frequency range” allows to enter the frequency range in
which the sound source is calibrated. In general this will be 100 Hz to
10 kHz which is the default. “Number of points” specifies the number of
(logarithmically spaced) frequencies measured for the sound source
equalization.

“High pass (rumble) filter” allows to set a high pass filter which is active
in most measurements except distortion measurements, battery current
measurements and noise measurements. The edge frequency of the high
pass filter can be set, and the filter can be activated and deactivated. The
high pass filter is not applied to battery current measurements.
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If “File defined” is deactivated, the edge frequency can be set in the “Limit
frequency” field. The R&S UPV firmware then calculates the filter
coefficients and the delay to account for the filter settling. If “File defined” is
activated, a file with filter coefficients can be loaded using the “Browse”
button. A measurement delay for the filter settling time can be set manually
if the “Def. delay” checkbox is activated.

Highpass Filter

¥ Active

Lirnit frequency IE Hz
¥ File defined Browze |

ID:'xLl P UserHP_100HZ. COE

V¥ Def. delay I EEIE: mz

Cancel | )3

o

Fig. 10 Input window for filter settings

“Low pass (hiss noise) filter” allows to set a low pass filter which is active
in most measurements except battery current measurements and noise
measurements. The edge frequency of the high pass filter can be set, and
the filter can be activated and deactivated. The low pass filter is not applied
to battery current and distortion measurements.

The settings in the “Lowpass Filter” window are according to those for the
highpass filter.

With noise measurements, the filters from the “Options” menu are only
applied to the gain measurement. The noise measurement has own
parameters for the band limits of the noise level measurement.

Note: Filters slow down the measurement. Therefore they should only
be used if necessary. In particular a combination of selective
measurement with high pass and / or low pass filter is not
recommended.

“Adaptive measurement (function settling)” causes gain and level
measurements to be repeated until the result has settled within a specified
tolerance. This is helpful to assure that an AGC which is present in the
signal path has adapted to the applied input signal of the hearing aid.
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¢ settling i [=]

¥ Active
Type

" Exporential (% Flat

Samplez Iﬂ
Tolerance IW b4
Resolution [ 40.0=] dBSPL
Tirneaut IW 3

Cancel | k. I
y

Fig. 11 Input window for adaptive measurement

With the “Flat” type, measurements are repeated until the last “Samples”
number of results are within the given “Tolerance” or the difference
between two subsequent measurement results is below the “Resolution”
value. The “Resolution” can be used to take into account the idle channel
noise of hearing aid and measurement equipment.

Note: The resolution value must be set high enough to take idle
channel noise into account. If it is set too low, especially
measurements with high gain at low input levels may be aborted due
to invalid result values.

Note: If the use of filters leads to slow measurements, the timeout
value may have to be increased.

With the “exponential” type of settling, differences between the earlier
results may be higher than specified, but the results must converge
exponentially into the specified values.

If the settling time of the hearing aid is known, measurement may be faster
with settling turned off. In this case the known settling time has to be
entered as pre-delay in the measurement parameters of each
measurement.

Function settling is generally not applied to battery current measurements.
For harmonic distortion measurements the resolution is set fix to 0.01 %
THD.

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For details
on the handling of calibration data see section 4 (“Calibration”) below.

If “Select ear simulator at startup” is checked, the selection window for
the ear simulator is opened at each start of the program.
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“Ambient conditions” allows to change the temperature, relative humidity
and atmospheric pressure values for the protocol.

“Query ambient conditions at startup” causes the input window for the
ambient condition to be opened at each start of the program.

“Test method” allows to select the test method for transfer
measurements. With “Substitution”, the nominally set SPL at the input of
the hearing aid is assumed to be correct, due to the calibration of the sound
source. With “Comparison”, the input SPL is measured simultaneously with
the output SPL by the reference microphone in a two channel
measurement, and results are corrected for the deviation of the input SPL
from the nominal value. “Comparison” can not be selected when the
continuous current measurement is active or when the coupler microphone
is used as reference microphone (see below).

“Microphone Location MLE (IEC 60118-15)" allows to specify the
location of the hearing aid. The respective frequency correction (“location
effect”) according IEC 60118-8 is taken into account for speech tests
according to IEC 60118-15.

- None: No location effect is taken into account

- BTE: Location effect for hearing aids worn behind the ear

- ITE: Location effect for hearing aids worn inside the concha

- ITC: Location effect for hearing aids inserted into the ear canal

- CIC:Location effect for hearing aids which are worn completely inside
the ear canal.

“Use coupler mic as reference mic” allows to use the microphone of the
IEC 126 coupler for sound source calibration. In this case the program
applies the calibration value of the coupler microphone for the sound source
calibration, and the reference microphone has to be connected to analyzer
input 1 instead of analyzer input 2.

If “Show operator instructions” is checked, instructions to the operator
are displayed in a message box before the measurement starts. The
operator may be prompted to position the hearing aid in a defined way or to
set the volume to a certain setting.

In Menu item “Delay before closing a measurement in a sequence” a
time period can be defined for which the result of a completed
measurement is shown during execution of a sequence, before the
measurement window is closed and the next measurement in the sequence
is started.

“Store results of further measurements” allows to include results
obtained with the “Add measurement” softkey to the result database. All
curves obtained this way will be reported in the same graph. This allows
e.g. to measure responses depending on settings of the hearing aid, and to
report them in a field of curves.

“Store Loaded Curve Data to results” includes curve data which is
loaded with the button “Load Curve” to the result database such that the
loaded curves will appear in the diagram of the respective report.

“Battery voltage” allows to specify the supply voltage for the hearing aid. If
a supply voltage is specified in the parameters of a measurement, the
general setting is overridden. This allows to measure response curves for
different supply voltages within one sequence.

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.
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Calibration Devices

R&S UPV-K7 allows to simultaneously store calibration values for multiple
individuals of the same type. This allows to switch devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

@Hearing Aid Tests
File Data | Calibration Measurement Sk

v Seleckive |

& el Microphone k
b

Ear Sirmulatar L)
Pistonphone
Sound Source

Induckion Caoil

Current Sense Resistor
1Py Calibrakion Info
Mew Device

Select Device

Show Selected Devices

Show all Yahues

Fig. 12 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button.

@Ealihrated Device _ O]

Uzage

| =

Type

M arifacturer

Sernial Hurmber

Cancel | | Save and cloze 2

Fig. 13 Input window for information about calibrated device
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Before a device can be calibrated or used, it must be selected with
“Calibration > Select device” in the main menu. Clicking on this item opens
a window with a table of all entered devices.

®5elect Calibrated Devices M =]

| Manufacturer | Type | SerialMa. | Date and Time | Calib. value | File name
Default 1/10/2007 £:24 PM [rudll) D:\Hearing4Call

G.RAS 404G 1234 1112007 11:0040  [rdll) D:\Hearing\Call
D efault 141042007 £:24 P [rull) D:\HearingsCall
D efault 141042007 £:24 PM [rudll) D:\Hearing Calz
Default 1/10/2007 B:24 PM [rwall) D:AHearing4Cal=
Default 1/10/2007 B:24 PM [rowall) D:\Hearing4Cald

|SeleclUsageTypE j Seleat | Cancel | Ok I

Fig. 14 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with @ mouse click on its left end. A mouse click on the button “Select’
selects this device for the associated usage.

®5elect Calibrated Devices M =]
| Manufacturer | Type | SerialMa. | Date and Time | Calib. value | File name

G.RAS 404G 1234 14172007 11:0040M  [nwll] D:\HearinghCall
Default 1/10/2007 6:24 PM [rwll] D:\HearingCall

[JEC 125 Coupler Microphane =] Select | Cancel | o |

Fig. 15 Selection window for particular device type (here IEC 126 coupler)

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K7 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.
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To simplify the procedure for the case that it is not intended to use multiple
devices of the same category nor to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

Microphone Calibration

> Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

> Call the test routine with “Calibration - Microphone 2> Coupler” or
“Calibration - Microphone - Reference” from the main menu,
depending on the microphone.

Zonnect microphone to Anakvzer input 1.
Insert microphone into calibrator and switch on calibrakar.

I

K

Fig. 16 Initial window of microphone calibration

Next, the nominal SPL of the calibrator has to be entered:

M arminal W alue I 124_003: dB5PL

¥ Apply Comection Yalues for Pistonphone

Yaolume Caorrection I -I]_EDE: dB5PL
Atmozphenc Corection I FEI_EEIE: dB5SPL

Effective Pressure Level I 1235 dBSPL

Cancel | Ok |
A

Fig. 17 Input window for calibration SPL

Checkbox “Apply Correction Values for Pistonphone” allows to specify
volume correction and atmospheric correction values which are added to
the nominal calibration value to calculate the effective pressure level at
the microphone during calibration. If this checkbox is checked, the
default for the nominal calibration value is 124 dBPL. If the calibration
values are deactivated, the default is 93.98 dBSPL.

If selective calibration is activated in the calibration menu, the frequency
of the calibration signal has to be entered:
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Calibration Frequency [Hz]
I 1 EIEIEI.EIEIE:

Cancel | Ok I

4

Fig. 18 Input window for calibration frequency

If correction values for pistonphone are used, the default for the
calibration frequency is 250 Hz. Otherwise the default calibration
frequency is 1000 Hz.

Subsequently, the output voltage of the microphone is measured and
the sensitivity displayed with reference to 1 Pa. If a mere power supply
without gain is used, the displayed sensitivity must approximately match
the value in the calibration certificate of the microphone capsule (typical
value for microphone capsule 4134 of artificial ear 4185 is approx.
12 mV/Pa, display = 120 mV/Pa). If a conditioning amplifier with 20 dB
gain (recommended value) is used, the displayed sensitivity must be
about 10 times higher. If the voltage measured is below 3 mV or
instable, an error message is displayed. Possible error sources are, for
example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the calibration is
repeated. After switching on the microphone power supply, wait approx.
20 s before starting the calibration again.

Calibration of Ear Simulator IEC 711

For calibration of the IEC 711 ear simulator, an adaptor part must be
screwed onto the simulator which allows it to be inserted into the calibrator
like a ¥2” microphone. The calibration routine is started with “Calibration >
Ear Simulator > IEC 711" and follows the course described above.

Entering correction values for Pistonphones

With the menu Item “Pistonphone” in the “Calibration” menu, volume and
atmospheric correction values can be viewed and edited. In addition the
default nominal level and calibration frequency for pistonphone use can be
modified.

Volume correction values are specific to the different microphone or coupler
types and can therefore be entered separately. The atmospheric correction
value is common to all microphones and ear simulators.
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Pistonphone Correction ¥alues

 Default Walues

Maminal Lewel 124.0= dE

Frequency 2a0.0= Hz

—olume Carrection

IECT11 Coupler 0.20=4 dB
Coupler Microphone -0.26=d dB

Reference Microphone | -0.40=4 dB

Atmozphernc Corection

All Microphones 0.30=4 dB

Ok

Cancel

nd | ddd ol d

e

Fig. 19 Input window pistonphone correction values

Calibration of Sound Source

Before a hearing aid can be tested, the absolute sensitivity and frequency
response of the sound source have to be measured and corrected with the
aid of a previously calibrated reference microphone. If “Use coupler mic as
reference mic” is activated in the “Options” menu, the microphone of the
IEC 126 coupler can be used for this purpose. The frequency response of
the microphone can be ignored in the test frequency range (100 Hz to
10 kHz) (see also calibration certificate of microphone capsule). If a
separate reference microphone is used, this has to be calibrated
beforehand with “Calibration - Microphone > Reference”.

After starting the sound source calibration with “Calibration - Sound
Source”, the calibration level can be defined. This allows to adapt the
calibration to specific measurement levels. It is also possible to store
calibrations for different levels using multiple calibration devices (see
above).

The sound pressure generated at the point of the reference microphone is set to
exactly the specified level in an automatic measurement routine at 1 kHz. The
generator voltage required is stored in a file on the hard disk and used as a
reference for all subsequent settings with the same sound source. If the sound
pressure cannot be adjusted to the specified value, an error message is
displayed with a request to check the connection to the sound source and to
repeat the measurement.

The uncorrected frequency response of the sound source is measured and
displayed. Next, the frequency response is measured with the inverse
frequency response correction automatically selected in the generator
(equalization). Residual errors caused by nonlinearities of the speaker are
measured and taken into account in the final equalization file as fine
correction.
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To verify the results, the absolute sound pressure versus frequency is
measured at the specified sound pressure level. Correct calibration without
interfering sound yields an almost straight line.

Calibration of the International Speech Test
Signal (ISTS)

This item is only available with option R&S UPV-K71 installed.

@)Hearing Aid Tesks

File Data | Calibration Measurement Standards Config. Meas.  Sequer

v Selective

Sele  Microphone ¥ Jeasurement Title

_____ ETar Sirnulator » PLA0 [ANS1]

----- Fietmpluae Eference Test Setting [AM51]
Sound Source S T T T
Speech Test Signal (ISTS) k at 55 di SPL

_____ Induction Coil at 65 di SPL

_____ Current Sense Resiskar at 80 dB SPL

_____ v UPY Calibration Info at 65 and &0 dB SPL

_____ Mew Device at 55, 65 and 80 dB SPL

N Select Device at other level
----- Frany Selbelice] Bz equency Responze Induction (&
_____ Show all Yalues £ PL90 (IEC-0]

Fig. 20 Submenu for ISTS calibration

The calibration function performs the following actions on the ISTS:

e Pre-filtering the speech signal with the inverse frequency response
of the sound source (valid sound source calibration is prerequisite)

e Level alignment of the filtered signal

e Analysis of the longterm average spectrum and percentile spectra
at the reference point and limit check in comparison to the
requirements in IEC 60118-15.

e Analysis of the speech signal at the reference point as input signal
to the hearing aid (according to IEC 60118-15). Raw results like 3"
octave spectra over time and selected intervals in each 3" octave
for given percentiles are stored in files for later use in the
measurement function.

e Pre-filtering of the equalized signal according to the different
microphone location effects.

Standard speech levels are 65 dBSPL, 80 dBSPL and optionally 55 dBSPL.
Additionally calibration can also be performed at other levels if required.
Especially for low levels like 55 dBSPL, a low-noise microphone is required
to get correct values for the 30% percentile.

Before starting the ISTS calibration routine, either a coupler microphone or
a reference microphone must be calibrated. If the coupler microphone is to
be used for this calibration function, select “Optiones = Use coupler mic as
reference mic”. The coupler microphone must be connected to analyzer
input 1. If a separate reference microphone is to be used, “Optiones > Use
coupler mic as reference mic” must be unchecked. The reference
microphone must be connected to analyzer input 2.
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@ Wave Test Signal Calibration O]
55 dBSPL 65 dBSPL | 80 cBSPL |

90

a0

70

Level [4BSPL]
15 3 3z

o
=1

Limits | Pass

I 1 1 I 1 1 1 1 1 1 1 1 I 1
200 300 400 500 600 800 1000 2000 3000 4000 5000 6000 8000 10000
Frequency [Hz]
E LTASS E Lawer Limit E Upper Limit E E5 % E Lawwer Limit E Upper Limit
E Upper Limit l“- 0% E Lower Limit B Upper Limit H 99 % E Lawwer Limit

Cloze

Fig. 21 ISTS calibration result

For each calibrated speech level, the window contains a tab with a result
graph. Each result graph shows long-term average speech spectrum
(LTASS) and percentile levels for this speech level, together with limits
calculated from the nominal levels given in IEC 60118-15 for the ISTS at
65 dBSPL speech level £3 dB.

The calibration is valid even if not all limits are passed. Particularly ad
55 dBSPL it might be difficult to pass the limits for the 30% percentile.
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5 Data Entry for Reporting

Operator
Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is

activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data - Test object > New” a description of the device under test
can be entered.

D Test Object i =]

M ame

[
Type

M anufacturer

Senal Humber

[T &GC

Cancel | | Save and cloze Lﬁ

Fig. 22 Window for input of information about a test object

With “Data - Test object > Select” one of the entered test objects can be
selected. The data of this selected test object will be stored in association
with all measurements and appear on the associated reports if “DUT
information” is activated in the report settings.
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Functionality and control of the measurement macros

@)Frequency Response (Generic) _[O] =

59.887

50

40

30

Gain [dB]

20

1 1 1 1 I 1 I I 1 I 1
500 600 800 1000 2000 3000 4000 S000E000 8000 10000
Frequency [Hz]

B, codesPL HRa-41.45d2 [ Limit Gain

NoStandard  [IEC126 [Substiution  [ather | 15 jwide Band T

Display Level I Calculate HEA

Fig. 23 Example of a measurement window

Savﬁrﬁ‘g‘i: As Create Report Close

Mea?u?ement Save Curve As | Load Curve

When a measurement macro is started, e.g. from the “Measurement”
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

i e LN
Iz
Showe Cursar

Change Scale
Data Poink Size
Cornrment

Fig. 24 Context menu of the graph window

Zooming

When the “Shift’” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
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Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale M =]

# MininnLmm # I aximum
| 1 EIEI.EIEI::I | 1 EIEIIIIEI.EIEI::I
" kirinnam ol =R

| S000=] | 0.00=]
Caricel ok |
dnce | /

o

Fig. 25 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.

Fig. 26 Cursor with data display

Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.

ol
-3
(1000.00, 48.05)

g

Fig. 27 Data points with data display

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and noise values are
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calculated and displayed in the legend. However, limits are not checked.
This function can e.g. be used to compare different settings in a device
under test.

If the item “Store results of further measurements” is activated in the
“Options” menu, graphs and result values obtained with this functionality are
added to the results database and will appear later in reports on this
measurement. All curves obtained within the same measurement will
appear in the report in the same graph.

Storing and Loading Curves

All measured curves in the graph can be stored to an ASCII file, and stored
curves can be loaded back into the graph. The softkey “Store Curve” opens
a window in which a combo box offers choice between the legends of all
measured curves in the graph. The curve associated in which the selected
entry is stored to the file at the specified location.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose. Regarding the use of such limit curves see section
“Customizing Measurements” below.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format. For details see section “Preview
Window” below.

Generating a Landscape Report

Landscape reports are only available for frequency response graphs. They
show the result graph together with the measurement title and information
about the tested hearing aid and about the operator. The layout and scale is
fixed and cannot be configured.

A landscape report can be generated from the measurement window by
right-clicking into the result graph of a frequency response measurement
and selecting “Create Landscape Report” from the context menu.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K7 main window. All relevant data associated with
the measurement is imported to the results database. A new entry appears
for the measurement as new row on the bottom of the overview data grid in
the main window.
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Customizing Measurements

The first item in the “Measurement” menu which is called “Settings” opens a
sub-menu with all available measurements in it. Clicking on a measurement
in this sub-menu opens a window which allows to change parameters of the
selected measurement.

@)Parameters of Frequency Response (Generic) =] E3

Template Files

Wal Fils Mame | Upper margin [dB] Lawer margin [dB

Gain or output level over frequency with input

level as parameter,

Add Humber = Delete Ed
14442007 10.0351 &M

0O perator instruction

Parameters

Connect output of hearing aid to measurement = NO‘ Name | Tupe | Default Valud Fi 2
coupler. Set gain control to pre-defined position 1 battery voltage [v) Double 1.5|Fal{
and switch on hea_l!mg aid. Place hearing aid in 2 lower Irequancy limit [Hz) Doutle 200/ Falt
reference test position — S
3 upper frequency limit (Hz] Double 5000 Fal:
LI 4 number of frequencies Integer 57| Fals
= = 5 display result az gain Boolean true| Fals
e E selective measurement Boolean False | Fal:
FR1 7 number of sweeps Parameter 1/|Fal:
8 sweep 1 level [dB] Double B0/ Fals
Nul T 9 measurement delay [s] Diouble 0.02 Fals
10 inductive EBoolean false Fal:
1 FR1 zet
11 number of HFA, frequencies Parameter 3 Fali-
4 o
Humber 13: Edit
Number = | Edt Cancel

Fig. 28 Measurement setup window

The “Title” appears in the measurement menu and forms the heading of the
report.

The “Description” can be chosen to be included into the report.
“Date” shows the date of the last change to this measurement definition.

“Operator instruction” is the text displayed before the start of each
measurement, provided that the item “Show operator instructions” is
activated in the “Options” menu.

The entry in the field “Program File” designates the measurement type and
must not be changed.

The field “Setup Files” specifies the R&S UPV setups used by the
measurement. The specified file can be replaced by a user defined file but
the number of setups is defined by the measurement type. The customized
setup file must be stored in folder D:\Hearing. It is recommended to
generate customized setups by copying existing ones. Note that changes in
the setup like changing the analysis function or generator signal may cause
malfunction of the measurement. Some parameters of the setup might be
overwritten by the macro during the measurement run.

The field “Template files” specifies limit template curves for the response
curve. The buttons “Add” or “Edit” produce the following input window:
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Template Curve
Mumber I1

| Upper lirnit |

Lower limit |

File name Browse |

Cancel | Ok

o

Fig. 29 Input window for limit template curve

The radio buttons allow to determine whether the given curve should be
used as upper limit, lower limit or for information only (no limit check). The
field “File name” must contain the path name of the file. To generate a new
limit curve file, use the softkey “Save as limit curve” of the respective
measurement window or copy and edit an existing limit file using a text
editor.

All other available parameters of a measurement definition are shown in the
“Parameters” data grid. The rightmost column with the headline “Fixed”
displays whether the respective parameter can be changed by the operator
or not. In “generic’ measurements all parameters may be changed. In
measurements which follow standards, only parameters which are not
determined by the standard may be changed by the operator. The “Edit”
button opens an input window for the parameter in the line specified in
“Number”:

Mumber I 1

Mame

battery valtage V]

Type

I Double j

Walue
[1.5

= Locked

Cahicel | Ok I
4

%

Fig. 30 Input window for parameter value

Alternatively this input window can be opened by double-clicking on the row
header of the parameter to be edited.

“Name” appears in the report and explains the meaning of the parameter.
“Type” is determined by the measurement routine and cannot be changed.
In the field “Value” a value must be entered which conforms with the syntax
rules of the selected data type. The syntax is checked automatically when
the text box is left. However there is no check for the allowable range of the
value. Entering inadequate values (e.g. too high levels, negative
frequencies) may cause malfunction of the measurement.
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Notes on Individual Measurements

Frequency Response Measurement

@Frequency Response {(Generic) 19 [=] 3

59887
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Display Lewel I Calculate HEA Add

I eazLrement
Fig. 31 Display window of frequency response measurement

Save Curve As

Linit Fils [T

Create Report

Save Curve Az | Load Curve

The softkey “Display Level” or “Display Gain”, respectively, allows to toggle
between gain and level in the Y axis of the graph. The button “Calculate
HFA” allows to calculate a high frequency average or special frequency
average from one of the displayed curves:

HFA frequencies [Hz] Calculate HEA Far
1000 Curve with inputk lesel

1600 ~
beno |en.oode =l

Calculate

4343 dB

il

Cloze

Fig. 32 Input window for HFA calculation

In the text box on the left side the HFA frequencies are entered in separate
lines. In the combo box top right, one of the existing curves is chosen.
When the button “Calculate” is clicked, the text box below shows the
associated HFA value.
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The following table lists all available parameters in the generic frequency

response measurement:

Name

battery voltage (V)

lower frequency limit (Hz)
upper frequency limit (Hz)
number of frequencies
display result as gain

selective measurement
number of sweeps
sweep 1 level (dB)

measurement delay (s)

inductive

number of HFA frequencies

HFA frequency 1 (Hz)

HFA frequency (Hz)

HFA frequency (Hz)

HFA upper limit (dB)

HFA lower limit (dB)

check limit for sweep no.
calc. freg. range for swp. no
level difference (dB)

check frequency range limits

max. lower frequency (Hz)
min. upper frequency (Hz)
display curve maximum

lower limit of max. (dB)
upper limit of max. (dB)
check max limits for swp. no

Type
Double

Double
Double
Integer
Boolean

Boolean
Parameter count
Double

Double

Boolean

Parameter count

Double
Double
Double
Double
Double
Byte

Byte

Double

Boolean

Double
Double
Boolean

Double
Double

Byte

Value

0

200
5000
57
True

false

60

0.02

false

1000
1600
2500
30
10

20

True

500
3500
True

40

Explanation

Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general
setting”.

Start frequency of sweep

Stop frequency of sweep
Number of sweep points

»True": Gain on Y axis, ,False™:
SPL on Y axis

.True": Selective measurement
with fast 3rd octave filter
Number of sweeps with level as
parameter

Sweep level for each sweep
(dBSPL or dB re 1 mA/m)
Pre-delay between sweep Step
and measurement trigger,
allows for settling of the DUT
(e.g. AGC)

“False”: Acoustic input, “True":
Inductive input

Number of frequencies
averaged in the high frequency
average

Upper limit for limit check
Lower limit for limit check
“0" means: “don't check”
“0" means: “don't calculate”

Level difference between HFA
level and frequency response
limit points

Determines whether the
frequency range is checked
against the limits given below

Stipulates whether the absolute
curve maximum should be
determined

“0" means: “don't check”

Table 1 Available parameters for frequency response measurements
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If for example only an upper limit should be checked but not the
corresponding lower one, select the lower limit low enough to be always
passed.

The following standard conformal tests are based on the frequency
response measurement routine:

Frequency Response @ 60 dBSPL (IEC-0)
Frequency Response (ANSI)

Field of Frequency Response Curves (IEC-0)
Frequency Response (IEC-7)

Frequency Response Induction (ANSI)
Frequency Response Induction (IEC-1)
Full-On Gain 50 dB (IEC-0)

Full-On Gain 60 dB (IEC-0)

Full-On Gain (IEC-7)

Response Curve at Maximum Gain (IEC-1)
Full-On Gain (ANSI)

Output SPL at Maximum Gain, Induction (IEC-1)
OSPL90 (ANSI)

OSPL90 (IEC-7)

OSPL 90 (IEC-0)

Multi-Curve Measurement
@Multi—[urve !E |

110

100

Output Level [dBSPL]

] ] ] ] ] ] [ [ ] [ ] [l [ ]
100 200 300 400 500EO0 2001000 2000 3000 400050006000 S00M 0000
Frequency [Hz]

E 50 dBSPL HFA = 96.96 dBSPL Max. = 103.41 dBSPL E 30 dBfrd/m) HFA = 97,16 dBSPL Max. = 103.43 dBSPL
m B0 dBSPL HRA = 101.97 dBSPL Max = 106.67 dBSPL
n 20 dB[mé/m) HFA = BB.11 dBSPL Max = 9595 dBSPL

\ EC 711 [substiution  |Sample HearingAid1 | 1.3V |wide Band T

Save Curve As
Lirit File | Create Report

Done

Calculate HFA

Save Curve Az Load Curve

Dizplay Gain Meai;radment

Fig. 33 Display window of multi-curve measurement

The multi-curve measurement is found in “Standards -> Utilities”. It is
similar to frequency response measurements and allows measurement and
display of acoustic and inductive frequency responses in one window.
Unlike other measurements, the multi-curve measurement does not
automatically start a sweep when it opens. All sweeps are started by the
user using the “Add Measurement” button, even within sequences.
Therefore this window does not close automatically within a sequence but
has to be closed using the “Done” button.
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The following table lists all available parameters available for configuration
of the multi-curve measurement:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general

setting”.
lower frequency limit (Hz) Double 200 Start frequency of sweep
upper frequency limit (Hz) Double 5000 Stop frequency of sweep
number of frequencies Integer 57 Number of sweep points
display result as gain Boolean false »True": Gain on Y axis, ,False":
SPL on Y axis
selective measurement Boolean false »True": Selective measurement
with fast 3rd octave filter
measurement predelay (s) Double 0.02 Pre-delay between sweep Step

and measurement trigger,
allows for settling of the DUT

(e.g. AGC)

number of HFA frequencies Parameter count 3 Number of frequencies
averaged in the high frequency
average

HFA frequency 1 (Hz) Double 1000

HFA frequency (Hz) Double 1600

HFA frequency (Hz) Double 2500

HFA upper limit (dB) Double 30 Upper limit for limit check

HFA lower limit (dB) Double 10 Lower limit for limit check

Determine maximum gain Boolean True Stipulates whether the absolute
curve maximum should be
determined

Show operator instruction Boolean True Determines whether the
operator should be prompted to
switch the hearing aid between
microphone and telecoil mode

Selective acoustic Boolean False Activates selective

measurement measurement for acoustic input
only

Selective induction Boolean True Activates selective

measurement measurement for inductione
input only

Table 2 Available parameters for multi-curve measurements

When the “Add Measurement” button is clicked, an entry window for the
level of the next sweep opens.

The input to the hearing aid can be switched between acoustic and
inductive signal. For acoustic input the level is set in dBSPL. For inductive
input the level can be entered in mA/m or dB(mA/m). If there are already
sweeps present in the graph, the input window always opens with the
settings done for the last sweep. In addition buttons are provided for
increasing or decreasing the level from the previous sweep by 1, 5 or
10 dB.
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Input Type
Acouzhc
[nduction
Input Lesel
| 1000 .
dB[rmd.Am]
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10 | A0de |
Cancel | Meazure !
#

Fig. 34 Entry window for sweep level in Multi-curve measurements

Saturation Sound Pressure Level Measurement

@Saturatiun SPL {Generic) 9 [=] 3
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NoStandard  [IEC126 [substiution  [ather | 15V wide Band T

| Meag?edment Sawe Curve As | Load Curve

Fig. 35 Display window of saturation sound pressure level measurement

Save Curve As
Lirnit File

Cloze

Create Report

The saturation sound pressure level measurement performs the specified
number of level sweeps and records the maximum level obtained in each
sweep.
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The following table lists all available parameters in the generic saturation
sound pressure level measurement:

Name Type Value Explanation

battery voltage (V) Double 1.5 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general

setting”.
lower frequency limit (Hz) Double 200 Start frequency of sweep
upper frequency limit (Hz) Double 8000 Stop frequency of sweep
number of frequencies Integer 65 Number of sweep points
lowest input level (dB) Double 60 Start level of sweep (dBSPL or
dB re 1 mA/m)
highest input level (dB) Double 90 Stop level of sweep (dBSPL or
dB re 1 mA/m)
number of levels Integer 31 Number of level steps in sweep
selective measurement Boolean false »True": Selective measurement
with fast 3rd octave filter
measurement delay (s) Double 0.02 Pre-delay between sweep Step

and measurement trigger,
allows for settling of the DUT

(e.g. AGC)

inductive Boolean false “False”: Acoustic input, “True":
Inductive input

display curve maximum Boolean True Stipulates whether the absolute
curve maximum should be
determined

lower limit of max. (dB) Double 130

upper limit of max. (dB) Double 150

check max limits Boolean true Stipulates whether pass / fail

check takes place

Table 3 Available parameters for saturation SPL measurements

The only standard conformal test based on the saturation SPL
measurement routine is Saturation SPL (IEC-0).
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Harmonic Distortion Measurement

@Harmonic Distortion (Generic) 9 [=] 3

[] [}
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Fig. 36 Curve display of harmonic distortion measurement

Save Curve As
Lirnit File

Save Curve Az | Load Curve Create Report Cloze

dd
Measurement

The softkey “Display dB” or “Display %”, respectively, allows to toggle
between both Y axis units. The softkey “Show Discrete Values” or “Show
Curves”, respectively, allows to toggle between curve display and result
data table provided that discrete values or curves, respectively, have been
measured.

@)Harmnnit Distortion {Generic) _ (O] %]
ResultData
Frequency | Lewvel | THD | THD limit | THD werdict ‘ 2nd ‘ 3id ‘ 4th ‘ Bth ‘ Eth |
70 5.343432468 1 Fail 525617 % 0896504 %  0.211765%  0143414%  0153519%
70 0.340588367 0.5 Pass 0111137 % 0311144 % 00728366% 00282066 % (.024544 %
0.838577806 0.5 Fail 0818163 % 018274 % 00114115 % 0.00845126  0.00748032

NoStandard —[IEC 126 [Substiution  [ather | 15y T
Digplay dB | Show Graph I Meai?edment

Fig. 37 Data table display of harmonic distortion measurement

Savﬁrﬁ‘g‘i: As Create Report Close

Save Curve As | Load Curve
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The following table lists all available parameters in the generic frequency
response measurement:

1401.9353.12-03

Name Type Value Explanation

battery voltage [V] Double 0 Supply voltage provided
at ANLG AUX OUT.
Overrides the general
setting. “0 V " means
“use voltage from
general setting”.

lower frequency limit [Hz] Double 200 Start frequency of sweep

upper frequency limit [Hz] Double 5000 Stop frequency of sweep

number of frequencies Integer 57 Number of sweep points

display result in dB Boolean false “False”: Y axis and
values in %, “True”: Y
axis and values in dB

number of sweeps Parameter count 3 Number of sweeps with
level as parameter

sweep 1 level [dB] Double 60 (dBSPL or dB re 1
mA/m)

sweep 2 level [dB] Double 80 (dBSPL or dB re 1
mA/m)

sweep 3 level [dB] Double 100 (dBSPL or dB re 1
mA/m)

measurement delay [s] Double 0.01 Pre-delay between
sweep Step and
measurement trigger,
allows for settling of the
DUT (e.g. AGC)

induction Boolean false “False”: Acoustic input,
“True”: Inductive input

show thd Boolean true Stipulates whether the
thd curve is displayed

show 2nd Boolean true Stipulates whether curve
of 2" harmonic is
displayed

show 3rd Boolean true Stipulates whether curve
of 3" harmonic is
displayed

show 4th Boolean false Etc.

show 5th Boolean false

show 6th Boolean false

show 7th Boolean false

show 8th Boolean false

show 9th Boolean false

check limit for sweep no. Byte 0 Stipulates whether limit
curve is checked. “0”
means no limit check

number of discrete points Parameter count 3 Number of discrete
measured values

point 1 [Hz], [dB], limit String 500, 70, 1 Value triples specifying
measurements and
upper limits

point 2 [Hz], [dB], limit String 800, 70, 0.5

point 3 [Hz], [dB], limit String 1600, 65, 0.5

check limits Boolean true Stipulates whether limits

are checked in discrete
measurements

Table 4 Available parameters for harmonic distortion measurements

37

E-3



Acoustic Measurements on Hearing Aids

The following standard conformal tests are based on the harmonic
distortion measurement routine:

Harmonic Distortion (ANSI)
Harmonic Distortion (IEC-7)
Harmonic Distortion (IEC-0)

Measurement of Dynamic Behaviour (AGC Settling)

@Dynamic Behaviour (Generic) 9 [=] 3
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120
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] ]
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Time [5]

m High level settling time = 16.513 ms Low level ettling time = 126,000 ms

NoStandard  [IEC126 [substiution  [ather | 15V wide Band T

| Meag?edment Sawe Curve As | Load Curve

Fig. 38 Measurement window for dynamic behaviour

Save Curve As

Linit Fils [T

Create Report

The dynamic behaviour measurement inputs a step-up and step-down burst
of a sinewave signal to the hearing aid. The output sound pressure level of
the hearing aid is plotted over time. The settling time is the time elapsing
from the level step until the level settles within a defined tolerance band
around the final output level. The tolerance bands and the settling periods
are indicated in the graph with dotted lines.

The following standard conformal tests are based on the dynamic behaviour
measurement routine:

Dynamic Behaviour (ANSI)

Dynamic Behaviour at High Level (IEC-2)
Dynamic Behaviour at Speech Level (IEC-2)
Dynamic Behaviour (IEC-7)
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The following table lists all available parameters in the generic dynamic

behaviour measurement:

Name

battery voltage (V)

test frequency (Hz)
high level (dB)

low level (dB)

on time (s)
interval (s)
selective measurement

induction

store diagram

display dB

attack tolerance (dB)

attack time lower limit (ms)
attack time upper limit (ms)

release tolerance (dB)

release time lower limit (ms)
release time upper limit (ms)

check limits

Type
Double

Double
Double

Double

Double
Double
Boolean

Boolean

Boolean

Boolean

Double

Double
Double

Double

Double
Double

Boolean

Value

0

2000
80

55

0.25

False

false

true

true

20

150

50
300

true

Explanation

Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general
setting”.

Frequency of sine burst tone
High level of sine burst (dBSPL
or dB re 1 mA/m)

Low level of sine burst (dBSPL
or dB re 1 mA/m)

Duration of high level

Period duration of sine burst

“True”: Signal filtered with one
octave width around test tone
frequency

“False”: Acoustic input, “True":
Inductive input

“False”: Only values are stored
in the database (saves disk
space), “True” compressed
curve is stored in the database
“False”: Sound pressure on Y
axis, “True”: SPL on Y axis
Settling time is determined as
the time after which the curve
approaches the steady value
closer than this difference
Lower limit of high settling
time for limit check

Upper limit of high settling
time for limit check

Settling time is determined as
the time after which the curve
approaches the steady value
closer than this difference
Lower limit of low settling time
for limit check

Upper limit of low settling time
for limit check

Stipulates whether limits of
settling times are checked

Table 5 Available parameters for dynamic behaviour measurements
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Measurement of Input-Output Characteristics
B[

@Input - Dutput Characteristics (Generic)
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NoStandard  [IEC126 [substiution  [ather | 15V wide Band T
Display Giain I CE;IS.UIIZ?;D Meag?edmemt
Fig. 39 Measurement window for input-output characteristics

The softkey “Display Gain” or “Display Level”, respectively, toggles the Y
axis data between gain and sound pressure level. With the softkey
“Calculate Comp. Ratio” a compression ratio may be calculated for any of

the measured curves.

Compression Ratio

Calculate
COMmpreszion ratio for
curve with frequency

80.00=  [2000Hz =]
Upper Level

AT 5.61

Cloze |

Fig. 40 Window for calculation of compression ratio

With “Lower Level” and “Upper Level”’ the input levels for the compression
ratio calculation are determined. The combo box top right selects one of the
measured curves. When the button “Calculate” is clicked, the compression
ratio is calculated and displayed in the text box below.

Save Curve As
Lirnit File

Cloze

Create Report

Save Curve Az | Load Curve

Lawer Level
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The following table lists all available parameters in the generic input-output

measurement:

Name

battery voltage (V)

lowest input level (dB)
highest input level (dB)

number of level steps
display result as gain

selective measurement
number of sweeps

sweep 1 frequency (Hz)
sweep 2 frequency (Hz)
sweep 3 frequency (Hz)
measurement delay (s)

induction

calculate values

AGC threshold upper limit
(dB)

AGC threshold lower limit
(dB)

compression input level 1
(dB)

compression input levl 2 (dB)

compression ratio upper limit
compression ratio lower limit

check limit for curve no.

Type
Double

Double
Double

Integer
Boolean

Boolean
Parameter count

Double
Double
Double
Double

Boolean

Boolean

Double
Double

Double

Double

Double

Double

Byte

Value

0

40
90

50
false

False

500
1000
2000
0.05

false

true

80
60

80

85

Explanation

Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general
setting”.

Start level of sweep (dBSPL or
dB re 1 mA/m)

Stop level of sweep (dBSPL or
dB re 1 mA/m)

Number of level steps in sweep

“False”: Level on the Y axis,
“True”: Gain on the Y axis
“True”: selective measurement
with fast 3™ octave filter
Number of sweeps with
frequency as parameter

Pre-delay between sweep Step
and measurement trigger,
allows for settling of the DUT
(e.g. AGC)

“False”: Acoustic input, “True":
Inductive input

“True”: AGC threshold and
compression ratio are
determined for each curve
Upper limit for limit check of
AGC threshold

Lower limit for limit check of
AGC threshold

Lower input level for
compression ratio calculation
(dBSPL or dB re 1 mA/m)
Higher input level for
compression ratio calculation
(dBSPL or dB re 1 mA/m)
Upper limit for limit check of
compression ratio

Lower limit for limit check of
compression ratio

“0” means “don't check”

Table 6 Available parameters for input-output measurements

The following standard conformal tests are based on the measurement
routine for input-output characteristics:

Input-Output characteristics (ANSI)
Input-Output characteristics (IEC-2)
Input-Output characteristics (IEC-7)
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Measurement of Equivalent Input Noise
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Fig. 41 Measurement window for equivalent input noise

The test routine for equivalent input noise determines the gain at an
average of pre-defined frequencies. The output noise is measured, and the
equivalent input noise is determined by subtracting the gain from the output
noise level. In addition to the wideband input noise, it is optionally possible
to measure the 3" octave spectrum of the equivalent input noise.

Additional measurements can be performed with sealed input and with
hearing aid switched off. The equivalent input noise with sealed input
should not differ significantly from that measured with open input because
otherwise the noise must be assumed to be picked up from the acoustic
environment. The noise measured with hearing aid switched off should be
significantly lower than the measured equivalent input noise, because
otherwise the noise must be assumed to be at least partly generated by the
coupler microphone.
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The following table lists all available parameters in the generic
measurement of equivalent input noise:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general

setting”.

lower cutoff freq. (Hz) Double 175 Lower band limit for wideband
noise measurement

upper cutoff frequency (Hz) Double 5650 Upper band limit for wideband
noise measurement

gain test input level (dB) Double 60 Level for measurement of gain
(dBSPL or dB re 1 mA/m)

integration time (s) Double 1 Integration time for noise
measurement

predelay (s) Double 0 Pre-delay between sweep Step

and measurement trigger,
allows for settling of the DUT

(e.g. AGC)

induction Boolean False “False”: Acoustic input, “True":
Inductive input

number of HFA frequencies Parameter count 1 Number of frequencies
averaged for gain measurement

HFA frequency 1 (Hz) Double 1600

check closed input Boolean True “True": Repeat noise

measurement with sealed input
and check level difference

max level difference (dB) Double 1 Maximum acceptable noise
level difference between input
open and input sealed

check off Boolean True “True": Repeat noise
measurement with hearing aid
switched off

min. level difference (dB) Double 10 Minimum acceptable noise

difference between hearing aid
switched of and hearing aid
switched on with input open

maximum noise level (dBSPL) Double 40 Maximum noise level for
pass/fail check

check limits Boolean True Stipulates whether limit should
be checked

display spectrum Boolean True “True”: Noise spectrum is

measured with a sweep of a
fast 3 octave filter

lower frequency (Hz) Double 200 Lowest 3 octave center
frequency

upper frequency (Hz) Double 5000 Highest 3" octave center
frequency

number of frequencies Double 15 Number of 3™ octaves

measured, must match the
number of 3™ octaves including
the lowest and highest one

Table 7 Available parameters for equivalent input noise measurements

The following standard conformal tests are based on the measurement
routine for equivalent input noise:

Equivalent Input Noise (ANSI)
Equivalent Input Noise 1/3 oct. (IEC-0)
Equivalent Input Noise (IEC-7)
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Battery Current Measurement

@Battery Current {Generic) =] E3

5

25

Batt. Current [rd]

40 50 0 70 a0 90
Input Lewvel [dB]
¥, 500+ B 1000 = I 2000 H:
‘Nn Standard |IEE nm |Enmpansnn |5amp|e Hearing &id 1 ‘ 1 3V| T
Show Discrete | Add Save Curve As
| Valuss Measurement Save Curve Ag Load Curve | Limit File Create Report Cloze

Fig. 42 Graphic display of battery current measurement

@Battery Current (Generic)

Result Data

Frequency (H | Lewvel [dB] | Current [méb] | Lower limit [m | Upper limit [m ‘ Werdict
» 1000 i 1.085509033 | 0.05 25 Pass
| | &0 1.324192271 005 5 Pass
| |1 a0 20801552391 005 a Pass

NoStandard |IEC 126 [substiution  [ather [ 15y T

I Add
| S EEgh Measurement

Fig. 43 Value table display of battery current measurement

Save Curve As

Linit Fils [T

Create Report

Save Curve Az | Load Curve

The softkey “Show Discrete Values” or “Show Graph”, respectively, toggles
between the graph view and the data table view of the measurement
window.
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The following table lists all available parameters in the generic battery

current measurement:

Name

battery voltage (V)

lowest input level (dB)
highest input level (dB)

number of level steps
number of sweeps

sweep 1 frequency (Hz)
sweep 2 frequency (Hz)
sweep 3 frequency (Hz)
measurement delay (s)

induction

check limits for curve no
number of discrete points

point 1 (Hz), (dB), lower limit,
upper limit

point 2 (Hz), (dB), lower limit,
upper limit

point 3 (Hz), (dB), lower limit,
upper limit

check limits

Type
Double

Double
Double

Integer
Parameter count

Double
Double
Double
Double

Boolean

Byte

Parameter count
String

String

String

Boolean

Value

0

40
90

50

500
1000
2000
0.05

false

2
3

1000,
0, 0.05,
2.5
1000,
60,
0.05,5
1000,
90,
0.05, 8
true

Explanation

Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general
setting”.

Start level of sweep (dBSPL or
dB re 1 mA/m)

Stop level of sweep (dBSPL or
dB re 1 mA/m)

Number of level steps in sweep

Number of sweeps with
frequency as parameter

Pre-delay between generator
setting and measurement
trigger, allows for settling of the
DUT (e.g. AGC)

“False”: Acoustic input, “True":
Inductive input

“0"” means “don't check”

Number of discrete measured
values

Value triples specifying
measurements and upper limits

Stipulates whether limits are
checked in discrete
measurements

Table 8 Available parameters for battery current measurements

The following standard conformal tests are based on the battery current

measurement routine:

Battery Current (ANSI)
Battery Current (IEC-0)
Battery Current (IEC-7)
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Speech Test according to IEC 60118-15

This test requires option key UPV-K71. Prerequisite is valid ISTS calibration
data. Purpose of the test is the characterisation of fitted hearing aids using
a speech-like signal.

The International Speech Test Signal (ISTS) has been composed from
segments shorter than 500 ms, taken from recordings with 21 female
speakers in six different languages (American English, Arabic, Chinese,
French, German and Spanish). Segments are mounted in sections of 10 or
15 seconds with pauses in between. The total length of the test signal used
in this software is 60 seconds.

The ISTS is equalized and pre-filtered as described in the “Calibration”
section. Recordings of the signal at the input and output of the hearing aid
are analyzed using the following steps:

e Input and output signal are time-aligned by a cross-correlation
delay measurement

e Both signals are filtered in third-octave bands with centre
frequencies from 250 Hz to 6300 Hz

e The RMS value within each 3™-octave band is determined in
sections of 125 ms length, overlapping by a factor of 2 such that a
level value is obtained every 62.5 ms

e A percentile analysis of the input signal is performed on the levels
pertaining to each third octave band (done during calibration).

e Within each third octave band, time sections are identified having a
level within 3 dB of certain percentile values (done during
calibration). As a standard, the 30", 65" and 99" percentile are
used. The 99" percentile is defined as the level to which 99% of the
samples are lower and 1 % of the samples are higher in level.

e For each combination of percentile and third-octave band, the
percentile gain is determined by subtracting the input level from the
output level of each selected section, and averaging the level
difference in all selected sections of this percentile/third-octave
band combination.

e For “Estimated Insertion Gain”, the open-ear gain given in
IEC 60118-8:2005 is subtracted from the gain result and correction
values for the difference between open-ear sensitivity and 2cc
coupler results are added to the output level values.

Usually multiple graphs result from one test run:

e Gain calculated from the long-term average speech spectra
(“LTASS gain”) at different speech levels

e Gain calculated from selected sections for certain percentiles
(“Speech gain”), one graph for each speech level

e If the delay is determined for each third-octave band separately, the
delay can also be plotted over frequency.

All graphs are contained within a tab control, where the tabs on top allow to
switch between the graphs. The softkeys / buttons on bottom of the window
are context sensitive, as far as applicable.
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< IEC 60118-15 EIG @ 55, 65, 80 dBSPL, Abs. =[oi]
LTASS | 65 cBSPL | B5dBSPL B0dBSPL |

90

a0

T

E0

50

40

30

Speech Gain [dB]

I I 1 I | I I I | | I | | i
200 300 400 500 600 200 1000 2000 3000 4000 50006000 2000 10000
Frequency [Hz]

P¥ Giain @ B0 dBSPL, 31z BN Gain @ B0 0BSPL G5% W Gain @ B0 dBSPL 992 1g¥) LTASS Gain @ A0 dBSPL
iEC 128 [BTE [Test Hearing 4id 1 R T
MNormalize | P\agligﬂmb‘lat‘nut | Meafl‘,l?edment Save Curve As Load Curve | safngi:#\iliz Az | Create Report Close

Fig. 44 Display of speech test

The “Play Output Signal” button allows to listen to the output signal of the
hearing aid. The speech level can be selected, whereas the speech level
which is currently on display is pre-selected.

Level and output volume can be set in the following window:

100 50 1]
¥ Speaker Enable ¥ Phone Enable
Clase
&= ,

Fig. 45 Volume control for replay of output signal

Caution: When using a headset, beware of excessive sound pressure.
Take off and / or disconnect the headset after listening and before starting a
new test.

The following table lists all available parameters in the generic speech test:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides
the general setting. "0 V *
means “use voltage from
general setting”.

Induction Boolean False Must always be “False”

lowest band Byte 4 Lowest analyzed 3"-
octave band. Band 0
corresponds to 100 Hz.

highest band Byte 18 Highest analyzed 3"-
octave band. Band 20
corresponds to 10 kHz

test signal (without file extension) String ISTS-V1.0_60s_16bit_48kHz
Currently only this signal
file is supported.

analysis start time (s) Double 15 Length of settling time.
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analysis length (s)

microphone location

number of signal levels

signal level 1 (dBSPL)
signal level 2 (dBSPL)
signal level 3 (dBSPL)
frequency-dependent delay

show freqg.-dep. delay

add OES2CCD for 2cc coupler

subtract OEG

show LTASS gain

normalize to level (dBSPL) ...

show speech gain

number of percentiles

percentage 1 (%)
percentage 2 (%)
percentage 3 (%)

include LTASS gain

normalize to LTASS gain

Double

String

Parameter
count
Double

Double
Double
Boolean

Boolean

Boolean

Boolean

Boolean

Double

Boolean

Parameter
count

Single
Single
Single

Boolean

Boolean

SELECTED

55
65
80
False

False

False

False

True

True

30
65
99

True

False

Table 9 Available parameters for speech tests
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Length of analyzed time
interval which starts after
completion of settling
time.

Microphone location effect
to be taken into account:
“SELECTED” means MLE
selected in Options. Other
values: “NONE”, “BTE”,
“ITE”, “ITC”, “CIC"
Number of signal levels to
be tested
Average signal level

Average signal level
Average signal level

Specifies whether the
delay should be
determined frequency-
selective

Specifies whether
frequency dependent
delay should be plotted in
an extra graph
Specifies whether
correction values should
be applied for 2cc coupler
Specifies whether open-
ear gain values from IEC
60118-8:2005 Annex B
should be subtracted from
the gain results
Specifies whether the
LTASS gains should be
shown in an own diagram
Specifies the LTASS gain
curve to which all curves
should be normalized. “0”
means no normalization.
Specifies whether the
percentile gain curves
should be shown in a
separate diagram for each
tested speech level.
Specifies number of
percentiles for which a
speech gain is determined
Selected percent value of
first percentile.

Selected percent value of
second percentile.
Selected percent value of
third percentile.

Specifies whether the
LTASS gains should be
shown in the speech gain
diagrams

Specifies whether the
percentile gains at each
level should be normalized
to the LTASS gain at the
respective level
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The following standard conformal tests are based on the speech test
routine (EIG = Estimated Insertion Gain, CG = Couple Gain):

IEC 60118-15 EIG @ 55, 65, 80 dBSPL, Abs.
IEC 60118-15 EIG @ 55, 65, 80 dBSPL, Rel.
IEC 60118-15 EIG @ 65, 80 dBSPL, Abs.
IEC 60118-15 EIG @ 65, 80 dBSPL, Rel.
IEC 60118-15 EIG @ 55 dBSPL, Abs.

IEC 60118-15 EIG @ 55 dBSPL, Rel.

IEC 60118-15 EIG @ 65 dBSPL, Abs.

IEC 60118-15 EIG @ 65 dBSPL, Rel.

IEC 60118-15 EIG @ 80 dBSPL, Abs.

IEC 60118-15 EIG @ 80 dBSPL, Rel.

IEC 60118-15 CG @ 55, 65, 80 dBSPL, Abs.
IEC 60118-15 CG @ 55, 65, 80 dBSPL, Rel.
IEC 60118-15 CG @ 65, 80 dBSPL, Abs.
IEC 60118-15 CG @ 65, 80 dBSPL, Rel.
IEC 60118-15 CG @ 55 dBSPL, Abs.

IEC 60118-15 CG @ 55 dBSPL, Rel.

IEC 60118-15 CG @ 65 dBSPL, Abs.

IEC 60118-15 CG @ 65 dBSPL, Rel.

IEC 60118-15 CG @ 80 dBSPL, Abs.

IEC 60118-15 CG @ 80 dBSPL, Rel.

Furthermore the test software provides non-standard short tests with a
settling time of 5 seconds and an analysis time of 15 seconds:

Short EIG @ 55, 65, 80 dBSPL, Abs.
Short EIG @ 55, 65, 80 dBSPL, Rel.
Short EIG @ 65, 80 dBSPL, Abs.
Short EIG @ 65, 80 dBSPL, Rel.
Short EIG @ 55 dBSPL, Abs.

Short EIG @ 55 dBSPL, Rel.

Short EIG @ 65 dBSPL, Abs.

Short EIG @ 65 dBSPL, Rel.

Short EIG @ 80 dBSPL, Abs.

Short EIG @ 80 dBSPL, Rel.

Short CG @ 55, 65, 80 dBSPL, Abs.
Short CG @ 55, 65, 80 dBSPL, Rel.
Short CG @ 65, 80 dBSPL, Abs.
Short CG @ 65, 80 dBSPL, Rel.
Short CG @ 55 dBSPL, Abs.

Short CG @ 55 dBSPL, Rel.

Short CG @ 65 dBSPL, Abs.

Short CG @ 65 dBSPL, Rel.

Short CG @ 80 dBSPL, Abs.

Short CG @ 80 dBSPL, Rel.

The short tests are meant to speed up alignment procedures and quick

tests, whereas precise testing according to the standard requires the full
analysis time of 45 seconds after a settling time of 15 seconds.
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Routine for Reference Test Gain Setting

@)Re[erence Test Setting (IEC-0) 19 [=] 3

Adjust volume setting of the hearing aid such that
the bar to the left is close to "0". If the bar is green,
the gain is within the specified tolerance.

OSPL HFA Current HFEA
10280 dB 10085 dB
Carnmert
[ Ec7m Substiuion  Sample HeaingAid1 | 1.3V Wide Band T
| | DONE | [Create Feport [Hase

Fig. 46 Initial display of the routine for reference test gain setting

At start of the macro, the full-on gain or output SPL is measured and
averaged at the specified HFA frequencies. From this value a target level is
calculated.

The gain of the hearing aid at the specified frequencies is repeatedly
measured until the “STOP” button is clicked. The thermometer shows the
deviation from the target value. If the deviation becomes smaller than 3 dB,
the scale is enlarged. The colour of the thermometer is red as long as the
deviation is higher than the allowed tolerance and turns green as soon as
the deviation is within tolerance.

@)Re[erence Test Setting (IEC-0) 19 =] S

54 Adjust volume setting of the hearing aid such that

the bar to the left is close to "0". If the bar is green,
the gain is within the specified tolerance.

| OSPL HFA Current HFEA
-1 102.80 dB 5795 dB
2
-3 Carnmert
-4
@
Ec7m Substiuion  Sample HeaingAid1 | 1.3V Wide Band T
| | DEHE | Create Repart Cloze

Fig. 47 Display of the routine for reference test gain setting, adjusted
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A comment to be printed with the report (e.g. setting of the gain control)
may be entered in the “Comment” field.

The following table lists all available parameters for reference test gain

setting:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general
setting”.

selective measurement Boolean false “True”: selective measurement
with fast 3™ octave filter

OSPL as gain Boolean false Stipulates whether the full-on
value is measured as gain or as
level

OSPL (dB) Double 90 Input level for the full-on
measurement

RTS as gain Boolean true Stipulates whether the value
during adjustment is measured
as gain or as level

RTS level (dB) Double 60 Input level during adjustment
(dBSPL or dB re 1 mA/m)

measurement delay (s) Double 0 Pre-delay between generator

setting and measurement
trigger, allows for settling of the
DUT (e.g. AGC)

induction Boolean false “False”: Acoustic RTS input,
“True”: Inductive RTS input,
OSPL measurement is always

acoustic

number of HFA frequencies Parameter count 3 Number of frequencies
averaged for gain measurement

HFA frequency 1 (Hz) Double 1000

HFA frequency 2 (Hz) Double 1600

HFA frequency 3 (Hz) Double 2500

level difference (dB) Double -77 Difference between target value
and full-on value

upper tolerance (dB) Double 1.5 Maximum allowed difference

between value during
adjustment and target value

lower tolerance (dB) Double -1.5 Minimum allowed between
value during adjustment and
target value

Table 10 Available parameters for the reference test gain setting

The following standard conformal tests are based on the reference test gain
setting routine:

Reference Test Setting (ANSI)
Reference Test Setting (IEC-0)
Reference Test Setting (IEC-7)
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Routine for Alignment of the Hearing Aid in the Magnetic Field

@Magnetic Field Alignment M=l
Maxirmum Current
80+ ) 80
1 1 Align orientation of the hearing
7 7 aid such that the indication in
204 204 the right bar is maximised!
65i 65i Masdmum
60+ 60
79.30 dB

50 50
45 45 Current
404 404

354 354

300 307

|IEE 11 |5uhstltuhnn | ‘ 13V |53\e:hve f

Fig. 48 Display of the routine for magnetic field alignment

Max. Reset Change Scale | Stop | Done

This routine shows the output SPL of the hearing aid with a defined
magnetic field strength in real time on a graphic thermometer display and
on a numeric display. In addition a “maximum hold” display is provided. The
maximum reading can be reset by clicking the “Max. Reset” button. The
range of the graphic displays can be adapted using the “Change Scale”
button.

The “Stop” button stops the continuous measurement and leaved the
window open. The “Done” button stops the continuous measurement and
closes the window.

The following table lists all available parameters for magnetic field
alignment:

Name Type Value Explanation

Selective Boolean True “True”: selective measurement
with fast 3™ octave filter

induction Boolean True “False”: Acoustic input,
“True”: Inductive input,

number of HFA frequencies Parameter count 1 Number of frequencies
averaged for gain measurement

HFA frequency 1 (Hz) Double 1600

Input level (dB re 1 mA/m) Double 20 Magpnetic field strength for
inductive input
SPL for acoustic input

level scale maximum (dBSPL) Double 80 Initial upper end of the graphic
display

level scale minimum (dBSPL)  Double 30 Initial lower end of the graphic
display

Table 11 Available parameters for magnetic field alignment
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7 Automatic Test Sequences
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@Hearing Aid Tests

File Data Calbration Measurement Standards  Config, Meas, | Sequence  Report  Options  He

Test Results Overvew Tesw
Select | Date and Time | Measurement Titls Open ...
| e 070242010 1 4:46:50 D5PLA0 (IEC-7) IS SR 2 S0

Fig. 49 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.

@Hearing Aid Tests 1=

Fle Data Calibration Measurement Standards Config. Meas. Segquence Report  Options  Help

B EC 118012 dped | [ OSPLOD(ECD)

- 05PLI0 [IEC-0) v Reference Test Setting (IEC-0)

+ Saturation SPL (IEC-0) Editand| Apmend) =2 | [w| Field of Frequency Respanse Curves(IEC-0]

Full-On Gain B0 dB [IEC-0] [ Input - Output Characteristics [IEC-2)

Full-On Gain 50 dB (IEC-0) [Eopy, Editand. Apm | [ Dynamic Behaviour at Speech Level [IEC-2)

- Fieference Test Setting [IEC-0) [ Harmonic Distartion (IEC-0]

. Fraquency Response @ 60 dBSPL IEC-0) Delete % | % ‘éa"?'ylcut"f”t [l'if'_”] -

- Field of Frequency Response Curves(|EC-0] Hiove | ¥ Ss:i’llI:: ?Dnte:’;iuoil olse

-~ Input - Output Characlerlsllcs (IEC-2] (v Adjust induction autput bo acoustic @ 60 dBSPL
- Dpnamic Behaviour at High Lewel [[EC-Z] R | ¥ Magretic Field Alignment

- Dynamic Behaviour at Speech Level IEC-2) [ Frequency Response Induction (IEC-1)

-~ Harmoric: Distortion (IEC-0] Edit Farameters | [ Mulli-Curve

- Battery Current IEC-0)

v Gain Adjustment Induction [IEC-1)

Equivalent Input Noise 143 oct. IEC-0) Frun hiohliahied | vl Harmonic Distortion Induction

Gain Adjustment Induction (IEC-1) [v| Create Ore-Page Report for IEC B0118:0.-1.-2

Freq. Resp. Induction & 31.6 ma&/m [|EC-1) Clear |

- Freq. Resp. Induction & 10 ma/m (IEC-1]

- Harmonic: Distortion Induction IEC-1] Check all |
- Responge Curve (@ Maw. Gain Induction [IEC-1]
- IEC118-7 Uncheck &l |
[ &NSI 53.22
[#- Generic Save sequence as |
[+ Utilties
[ Messages and Control Save squance |
- More ..

Enter Comment |

Cloze | Cloze measurement after 0 seconds Change

1 | e
IECTI801.2  ECFI [Substitution |sampe Hearng 2id 1| 1.300%
ji first Stop/Eart Hepeatlast Heport
easurEmERt Start sequence P ity [ ezt Sten | emstrement G Save sequence Save and close

Fig. 50 Sequence window

Initially the right checked list box is empty. The list box on the left side
displays all available measurement definitions, sorted by standards like in
the “Standards” menu. A measurement is appended to the sequence by
highlighting it in the tree view box on the left side and clicking the “Append”
button. Subsequently a measurement, which is highlighted in the checked
list box on the right side, can be moved within the sequence using the
buttons “Move up” and “Move down” and deleted from the sequence with
the “Delete X” button. It is possible to edit parameters which are not defined
by the standard before appending the measurement to the sequence. This
is done by clicking the button “Edit and append”. It is for example possible
to assemble a test sequence which repeats a certain test with different
battery voltages.
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Opening an Existing Sequence

The menu item “Sequence > Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence window opens with the specified
sequence loaded. The sequence can then be edited and/or run.

Using a Sample Sequence

Sample sequences are provided in the folder “C:\Program
Files\Rohde&Schwarz\UPV-K7 Hearing Aid Tests”. Before being edited or
run, the files should be copied to the current “D:Hearing” directory. This can
be done with menu item “Sequence - Insert sample sequence.

Sample sequences are provided for measurements according to IEC
60118-0,-1,-2, according to IEC 60118-7 and according to ANSI S3.22.
They can be used for collecting the data for the one-page reports.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox. Each measurement window may be kept open for a time period
defined in “Options = Delay before closing a measurement in a sequence
. This value can also modified on the bottom right corner of the
sequence window. In addition, a screenshot of each terminated
measurement is copied to a new tab in the sequence results overview:

@Hearing Aid Tests 1=

File Data Calibration Measurement Standards Config. Meas. Sequence Report  Options  Help

Fail IPass | Pass  Pass IFa\I IPass | Pass IPass | Pass IFai\ | = IPass | Pass I
1o

100

Input - Sutput Chara stic C-2)

Output Level [dBSPL]

I 1 ] 1 (!
50 E0 7l 20 124 57
Input Level [dBSPL]

m 800 Hz AGC Threshold = 87,69 dBSPL. Compression Ratio = 1.32 E 2000 Hz AGC Threshold = 67.80 dBSPL. Compression Ratio = 12.50
m 1000 Hz AGC Threshold = 73.69 dBSPL, Compression Ratio = £.34

[Ectiaaa2  [ECF |substitution |sample Heaing 2id 1~ | 1300

)i firgt Stop/Cant Nest Step | Hepeat [ast

Repart
MESEUEreHt: ZEnUENCE WMeasurement Hide Results Sawe and cloze

Sequence

Start sequence

Fig. 51 Sequence results window
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The view can be toggled between results and sequence by using the “Hide
Results” / “Show Results” bitton, respectively. Each tab indicates the verdict
(“Pass” or “Fail”) of the respective result. If the mouse is hovered into the
visible screenshot, the tooltip displays the measurement title. Alternatively
the tabs can also be configured in the context menu to show the titles of the
measurements.

Running a Single Measurement within a Sequence

When the softkey “Run highlighted” is pressed, the measurement currently
selected in the right checked list box is executed regardless of its checked
state. Results are added to the result database, however the measurement
started this way will not appear in the sequence report. This allows to use
sequences as customized sets of measurements which can be stored and
opened later again.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.
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8 Reporting, Storing, Loading and Deleting Results

1401.9353.12-03

Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

@Hearing Aid Tests

File Data Calibration &

Cpen resulks file
Save results
Save results as
Mew resulks file

Load settings
Save setkings
Save settings as

Exit

Fig. 52 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File > Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Save results as” from the main menu.

Report Settings

With “Report > Settings” or “Options = Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left, right-clicking into the data grid and
selecting “Generate report” from the context menu.
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. Create Report For Marked Row Eig—s
Create Landscape Report for Marked Row {Only For Frequency Response Resulks) FAlL
Delete Marked Row

PSS

Sawe Curve of Marked Row as ... =
{ Report Selected Results
Select all

Rep ian

1451:25 Frequency Response Induction [IEC-7) Sample Hearing Aid 1 Deselact 4l
14:51:53 Output SPL at Maximum Gain, Induction [EC- | Sample Hearing Aid 1 Bislctie Sileefier] Fresulis
15:10:38 Full-0n Gain [IEC-7] Sample Hearing Aid 1

Fig. 53 Results context menu

Subsequently data associated with the selected measurement is
assembled, a graph for existing curve data is generated, and the preview
window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Configuring the Landscape Report
Menu item “Report - One-Page Report Settings” opens the following input
window:

Landscape Report Settings

—Shyle
Color Black andhite |
i Curve |dentification

Legend | Label | Mone

iz Scaling

Chart Type ILeveI ws. Frequency j

—dzpect Ratio Frequency/Level Responze ——

Standard | Define
A Az
Auta | Define
Left | ‘IDD.DD::I Right | 1DDDD.DD::|
Y Az

Auta | Define

Bott [ B8000=] Top [ 15000

[+ Frint Infarmation on Test and Object

¥ Add Lines at 1600 Hz and 2500 Hz

Scale Chart Size by 1.00==

Cancel I ()8 I y

Z

Fig. 54 Data entry window for settings of the landscape report
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“Style” allows to choose between black-and-white and Color output.

“Curve Identification” specifies how to include the parameter Values for
the curves: in a legend below the graph, in a label inside the graph area or
not at all.

“Axis Scaling” can be configured for each combination of x axis unit and y
axis unit separately. “Standard” means automatic scaling to achieve the y
axis to x axis ratio defined in IEC 60118-0. “Define” enables the input fields
below.

In the “X Axis” and “Y Axis” fields, the scaling of each axis can be defined
for the specified combination of axis units. “Auto” uses the scaling from the
result dataset. “Define” enables the controls for the maximum and minimum
values.

The checkbox “Print Information on Test and Object” enables inclusion
of the measurement title and information about the tested hearing aid and
about the operator.

“Add Lines at 1600 Hz and 2500 Hz” enables inclusion of auxiliary vertical
lines at these frequencies, provided that the x axis unit is frequency.

Furthermore, the chart size can be scaled between 0.5 and 1.2. Information
text is included only with scale factors up to 1.0. A scale factor of 1.2
causes the graph to fill the whole A4 landscape page.

Generating a Landscape Report

A landscape report shows the result graph on an A4 landscape page. A
landscape report can be generated from the measurement window by right-
clicking into the result graph of a frequency response measurement and
selecting “Create Landscape Report” from the context menu. Furthermore a
Landscape report can be created from the results overview data grid in the
main window by marking a row in the results overview by clicking into the
row header, right-clicking into the results data grid and selecting “Create
Landscape Report for Marked Row”.

Multi-Curve

Hearing Aid:  Test Hearing Aid 1 Serial No.:  0815/4711
Manufacturer:  Hearing Damage Inc. Testedby:  Thomas Lechner
Comment:

0712802010 15:15:37 Rohde & Schwerz Audo Anshyzer UPY

60dBSPL; 90 dBSPL; 20 dB(mA/M); 30 dB(mAM)

Output Level [4BSPL]
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Fig. 55 Sample landscape report
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Selection Report

A report on a selection of measurements can be generated from the results
overview data grid in the main window by marking the rows with the desired
results in the “Select” column and choosing item “Report Selection >
Report Selected Results” (see Fig. 49). Rows marked with “XXXXX” in the
“Select” column will be added to the report. The selection can be toggled by
clicking into the respective “Select” cells. Note that another cell must be
clicked before the same cell can be toggled again.

Configuring the One-Page Report

Menu item “Report - One-Page Report Settings” opens the following input
window:

—Shile
Color | Black and White

i HF& Gain value at B0 dB, Telecoil
O5PL 1 md/m OSPL 10 m&/m |
i Frequency Response at Rel. Gain
Show Level Show Gain |
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Cancel 4

Fig. 56 Data entry window for settings of the one-page report

“Style” allows to choose between black-and-white and Color output.

“HFA Gain vale at 60 dB, Telecoil” selects whether the output sound
pressure level measured at HFA/ref. frequency with 10 mA/m is displayed
in column” Setting Telecoil” and row “Gain @ 60 dB @ REF, OSPL(1mA/m,
ref.)”, or whether a virtual value at 1 mA/m is displayed, calculated from a
measured value of 10 mA/m or 31.6 mA/m by subtracting 20 dB or 30 dB,
respectively.

In “Frequency Response at Ref. Gain” it can be chosen whether the
second diagram shows output sound pressure level values or gain values.

In “Curve ldentification” it is possible to choose between legends below
the respective graph (advantageous with color plots) and labels inside the
graphs (compatible with printouts from the UPL-B7 application program
“HEARPRO”.

The scaling of each graph can be configured in the “Axis Scaling” field.
The diagram is chosen with the numeric entry control, and the textbox
besides shows the title of the chosen graph. Autoscaling optimizes the size
of the curves while preserving the aspect ratio between the axes (10 dB on
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Y axis equals 10 dB on X axis for input-output curves and 50 dB on Y axis
equals 1 logarithmic frequency decade on the x axis for frequency response
graphs) like specified in IEC 60118-0 section 8 and in IEC 60263.

Checkboxes “Edit Comment”, “Edit Serial”’, “Edit Equipment” cause
the respective information to be displayed for editing during generation of
the report. If “Memorize Serial” is checked, the serial number is not taken
from the information about the selected test object but can be entered
during generation of the report. To ease entry of consecutive serial
numbers, the last entered number is always memorized and displayed as
suggestion for the next instance of the report.

Generating a One-Page Report

One-page reports are available for standards IEC 60118-0,-1,-2, IEC
60118-7 and ANSI S3.22. They can be generated for the test object
selected in “Data > Test object > Select” or for the test object selected in
“Report > Select by Object”.

Furthermore a one-page report can be generated from a sequence by
inserting a respective control item at the end of the sequence.

To assemble a one-page report, the report generator looks for the latest
results for the selected test object, with certain test names as listed below.
If the one-page report is generated from a sequence, however, it uses only
results obtained during the latest run of this sequence.

IEC 60118-0,-1,-2

IEC 60118-7

ANSI S3.22

OSPL90 (IEC-0)

OSPL90 (IEC-7)

OSPL90 (ANSI)

Field of Frequency
Response Curves
(IEC-0)

Frequency Response
(IEC-7)

Frequency Response

(ANSI)

Frequency Response
Induction (IEC-1)

or

Freq. Resp. Induction
@ 10 mA/m (IEC-1)

or

Freq. Resp. Induction
@ 31.6 mA/m (IEC-1)

Frequency Response
Induction (IEC-7)

Frequency Response

Induction (ANSI)

Response Curve @
Max. Gain Induction
(IEC-1)

Output SPL at
Maximum Gain,
Induction (IEC-7)

Output SPL at
Maximum Gain,
Induction (ANSI)

Multi-Curve

Multi-Curve

Multi-Curve

Equivalent Input Noise
(IEC-0)

Equivalent Input Noise
(IEC-7)

Equivalent Input
Noise (ANSI)

Harmonic Distortion
(IEC-0)

Harmonic Distortion
(IEC-7)

Harmonic Distortion
(ANSI)

Harmonic Distortion
Induction

Harmonic Distortion
Induction

Harmonic Distortion
Induction

Battery Current
(IEC-0)

Battery Current (IEC-7)

Battery Current
(ANSI)
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IEC 60118-0,-1,-2 IEC 60118-7 ANSI S3.22

10 | Dynamic Behaviour at | Dynamic Behaviour Dynamic Behaviour
Speech Level (IEC-2) (IEC-7) (ANSI)

11 | Input-Output Input-Output Input-Output
Characteristics (IEC-2) | Characteristics (IEC-7) Characteristics (ANSI)

Table 12 Measurement titles of the data sources for the one-page report

The following figure illustrates which of the above measurements serves as
data source for the respective areas of the one-page report:

Hearing Aid Test UPV - K7
ROHDE&SCHWARZ
Standard:  IEC60118-0, -1, -2 Tested by:  Thomas Lechner Time:  07/02/2010 15:30:06
DUT: Sample Hearing Aid 1 Type: KXR 7654 Manuf.:  AnyComp
Serial: 349876 AGC: Yes
Comment:
Equipment:  IEC 711 Coupler: Default , Sound Source: Default , Induction Coil: Default , Curr. Meas. Res.: Default
Measurement Results:
REF @ 1600 Hz Setting max Gain Setting ref Gain Setting Telecoil
Max OSPL90, OSPL(31.6 mA/m, ref.) 110.7 dB @ 2634 Hz 109.2 dB@ 2634 Hz 974 dB 3146 Hz
OSPL90, OSPL(31.6 mA/m, ref.) @ REF 103.4 dB 102.7 dl 90.8 dB
Max Gain @ 60 dB 48.8 dB 2753 Hz 37.0 dB @) 3146 Hz
Gain @ 60 dB @ REF, OSPL(tmA/m, ref.) 424 d8 201 d 50.333ﬁ Ao
Max Gain @ 50 dB 56.4 dB @ 2878 Hz 372 dB@ 3146 Hz
Gain @ 50 dB @ REF 50.7 dB 28.8 dB
Equ. Input Noise @~ 60.0 dB 19.9 86
THD @ 500 Hz, 70dB/ 100.0 mA/m 3.2 % 55 %
THD @ 800 Hz, 70dB/ 100.0 mA/m 09 % 09 %
THD@ 1600 Hz, 70dB/ 100.0 mA/m 0.3 % 0.1 %
Batt. Currentidle /@ 60dB, 1600 Hz 0.89 mA/ 9 0.89 mA
Attack/Release Time @ 80 dB/ 55 dB 14.1 ms/](140.0 ms
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Fig. 57 Data sources for one-page report (refer to table 11)
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Preview Window

@Repurt !E E
A N x&ERd= Q-
MainFeport |
ROHDE&SCHWAI
Tested: 1/11/2007 4:52:54 PM Print Date: 1/11/2¢
Operator:  Rohde & Schwarz
Device Under Test:
Name: other
Type: Standard
Manufacturer: Audiology Inc.
Serial Number: 23498576
AGC: No
Comment: This is my comment
LW AT hd
| 3
‘Current Page Mo: 1 ‘Total Page Mo: 1+ |Zoom Factor: 100%

Fig. 58 Report preview window

The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

N 4 F P
To open the print dialog for installed windows printers click

=,

To open a file selector for export of the report to PDF, WORD, EXCEL or
Rich Text format, click

e

The scale of the document in the preview can be adjusted with

EYH

Page width
= Whole Page
T 400% i
SO0
200
£ 50w i
= 10005
C e
o 50% i
?: Z25%
a Cuskamize...
T

Fig. 59 Scale menu of the preview window
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Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K7 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Shift Curve by 0= dB

Cancel | )3

3

Fig. 60 Input window for defining a shift of a measured curve for storage as
limit curve

Measured curves can be stored out of the results overview to an ASCII file
by right-clicking into the results overview and selecting “Save Curve of
Marked Row as ..."”. If the result contains more than one result, the user
can select which curve is to be stored, or alternatively choose to store all
measured curves into a common file. The file format can be tab separated
(“*.txt”) or comma separated (“*.csv”). *.csv files can be directly opened in
spreadsheet applications like MS Excel by double-clicking the file. Tab
separated text files can also be imported into spreadsheets.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to the hearing
aid being switched off, a wrong setting etc. To delete the result of a
particular measurement, mark the row for the selected measurement in the
data grid of the main window by clicking on the row header to the left, right-
click into the data grid and select “Delete result” from the context menu.
After confirmation by the operator, the selected row of the result overview
will be deleted from the result file together with all associated data (except
data also associated with other measurement results).

A set of results may be selected in the “Select” column of the results data
grid and commonly deleted using the context menu item “Report Selection
- Delete Selected Results”.
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Automatic Backup and Restoration of the Results File

In order to speed up the execution of sequences, the result file is only
saved when the program is closed. However, backups of the result file
called “*.xml~1" and “*.xml~2” are stored alternately after termination of
each single measurement and after termination of each sequence (**”
stands for the name of the results file without extension). If the program is
ended without closing it properly, or if the result file is not existing anymore,
the R&S UPV-K7 will by the time of its next start offer to restore the result
file from the latest backup file:

@Newer Backup File Found M= E3

The last session of this program has ended
prematurely. Mot all resulfs have been saved.

Last writing time of results file:
|H1 1/2007 4:12:11 PM|

Last writing time of backup file:
|H1 212007 9:40:08 AM

Wiould you like to backup the contents of the
resulfs file and restore the contents of the backup
file 7

Mo, keep results file | [ Yes, restore backup file |

Fig. 61 Restoration of data from backup file

If it is chosen to restore the result file from the backup, the supposedly
damaged result file is copied do “*.xmI~3” before the backup file is copied
to the original name of the results file.
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9 Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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